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PAPERLESS 3.0: MAKING YOUR PAPERLESS WORKFLOW WORK 

1. Considerations for Every Paperless Office 

The Benefits of Going Paperless/Making the Move 

 What is paperless 
 Consequences of too much paper 
 Costs of digital documents 
 Hardware—scanners, backup systems, monitors 

File Retention and Naming 

 Establishing protocols for file retention  
 Organization for easy retrieval 
 Training your staff 

 
Cloud-Based Storage 

• Privacy and Security Services 

Getting Your Team Committed to a Paper Free Environment 

 Checklists 
 Dealing with naysayers 
 Training the staff 

Keys to a Paperless Workflow: Adobe Acrobat DC and PDF Documents 

 Navigating PDF documents 
 Creating PDF documents 
 Editing and manipulating text 
 Assembling PDF documents 
 Working with forms and OCRing documents 
 Using headers and Reducing file size 
 Redacting information and Digital signatures 
 Bates numbering and Numbering pages 
 Document Security  
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2. Paperless 3.0 – The Struggle to Create a Truly Paperless Office Workflow 

The “paperless office.” Remember that concept? Like the idea that paper checks would disappear, the promise of a paperless 
office remains a pipedream for virtually every business, including law firms. Even after  “converting” to a paperless office, the 
mail still comes, faxes continue to fly out of the machine, and those e-mails remain endless. Thus, even most paperless offices 
struggle with the next level of efficiency. This program and this paper are designed to help you overcome the latest hurdles, 
while reminding you about the necessity for workflow revision and improvement.  

Consider a typical client file. In most cases, your office prepares an initial intake. It may be a detailed client interview, a case 
assignment sheet received from an insurance company, or something a bit more complicated. Regardless, you should have 
all of these scanned to your computer or your server, and named so that you (or anyone else) can locate the documents 
easily. There are two reasons to do this. First, it is all too easy to misplace documents, and scanned copies serve as insurance. 
Second, when the client calls, you no longer have to place the client on hold, get up from your desk, search for the file, and 
then, once you find it, rummage through the morass of papers to locate the document you need. Instead, you simply locate 
the document on your computer, open up the file, and you are ready to discuss the document in seconds. You are more 
efficient, and your client is impressed by your ability to discuss the document and the case at a moment’s notice. 

Let’s jump ahead a bit. Suppose the case requires you to obtain voluminous records. They could be medical records, financial 
records, or copies of contracts in dispute. Regardless, they encompass dozens, if not hundreds or possibly thousands of pages. 
In a traditional setting, you would have obtained hard copies of every document and would later supply paper copies to 
opposing counsel. That is a lot of dead trees, especially for records that, for the most part, probably will be reviewed only 
once; after all, only a small percentage of the records produced in most cases have any relevance to the case itself. More and 
more, however, records are either produced – or they are available – electronically, that is, in tif or pdf format on CD or floppy 
disk. 

If you’re already paperless, you should be taking advantage of the fact that when you need to review the file, if you only print 
and highlight the truly relevant documents, it is much easier to find these documents instead of having to fumble your way 
through reams of paper. 

Suppose, however, the matter involves litigation. Pleadings, discovery, motions, pretrial documents, etc. For my nickel, every 
document should be scanned and OCRed (optical character recognition). The paperless workflow not only renders the 
documents searchable, it generally also allows you to copy portions for use when preparing other documents. As a bonus, if 
you misplace a document (which of course will “never” happen), there is a copy readily available. In addition, when you file 
a motion, you can easily produce a CD rather than a case of paper, and at far less expense. Moreover, most courts now permit 
– or require – electronic filing. 

Scanners 

Scanners are a necessity. A scanner analyzes a document or other image and processes it in a way that allows you to save it 
on your computer. If the document contains text, a scanner can perform a scan of the text (Optical Character Recognition or 
OCR), thus allowing you to search by keywords and, depending on your software, use the text in other applications. If the 
document contains an image (picture), the scanner can save it in a manner that allows you to alter or enhance the image, 
print it out or use it elsewhere. 

In recent years, scanning technology has improved dramatically. Sheetfed scanners have become far more common and 
much more affordable, and allow you to scan large documents at the push of a button. For around $450.00, you can purchase 
a Fujitsu Scansnap scanner with a 35 to 50 page sheet feeder, which is sufficient for most small to mid-size firms. In addition, 
large copiers generally also serve as scanners. Either way, scanning is as easy as making a copy. 
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But the key to successful scanning is in the software. Most manufacturers supply all of the software you will need for free 
when you buy a scanner. For example, Fujitsu offers user-friendly software that makes scanning a snap. You open the 
software, click on the scan button, and the scanning begins. Once the scanning is over, the software asks you what format to 
save the images in, generally a pdf, and where to save it. Of course, if you need to save your document as an image, such as 
a tif or jpeg, you can do that just as easily. The advantage of the pdf format (rather than a jpeg or other “image” format) is 
that, with proper software, you can search one or more documents for keywords. 

After You Scan – You Need Software 

Scanning documents is just the first step. After your documents are scanned, you need the proper software to review them. 
Selecting the correct software for handling your documents is crucial to reducing paper and increasing efficiency. If you save 
your documents as pdfs, you can review them with the free Adobe Acrobat Reader (downloadable at 
http://www.adobe.com/products/acrobat/readstep2.html). Adobe Reader allows you to view your documents, but not much 
else.  

If you purchase Adobe Acrobat DC (the latest version – in either Standard or Professional), or comparable software, however, 
you can accomplish much more. For example, Adobe Acrobat easily performs an OCR on a document, allowing you to search 
its text, export it to Microsoft Word, or use it in other applications. Adobe Acrobat is relatively inexpensive and is the most 
versatile product of its type. 

One of the best features in Adobe Acrobat is its ability to index documents (Adobe calls it a “catalog”). In seconds, with an 
index, Adobe Acrobat can find every instance in which a word or phrase appears in one or many documents.  

File Retention and Naming  

Well defined file retention and naming conventions are an essential part of an effective paperless workflow. 

Does Your File Retention Policy Need a Check-Up? 

A cybersecurity expert recently said, “You should keep [client] information while you need it, but once the need is gone, get 
rid of it.” This comports with a lawyer’s ethical obligations to protect client information. Some states have guidance or rules 
on file retention, but rarely do they say, “keep files forever.” RPC 1.6, confidentiality, tells us to protect all client information, 
not just the secrets—that we should not be the source. Many states re enacting or strengthening data protection and breach 
disclosure rules, mirroring the General Data Protection Regulation enacted in the EU May 2018. In other words, having and 
following a file retention policy that has a finite, safe destruction date for all files is a fundamental part of your ethical 
obligations, as well as good office management.  
 
Unfortunately, many firms’ file retention policies look something like this: 
 

The firm keeps the file until death of the lawyer or of the firm, whichever comes first. 
 
Except it isn’t written down. Often, firms sacrifice entire offices and common areas to file storage or pay thousands of dollars 
a year for 20 years or more to file storage companies to maintain their files. A file retention policy could save them thousands 
of dollars a year and sometimes give them an additional office or two they could fill with staff or sublet out.  
 
A healthy firm file retention policy and closing file procedure commonly looks something like this: 

 We keep IOLTA records for five years because applicable Rules of Professional Conduct require it. (Check state rules 
because they vary, but foremost states require retaining IOLTA records for five or seven years). 
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 For client files, we have set retention periods for certain types of cases or clients. We keep most types of files for 
seven years. For minor clients, we keep it to age of majority plus three years to account for statutes of limitations. 
We have a “weird file exception” that applies when the managing partner decides a case or client is concerning and 
needs to be kept longer. 

 After a client gets a result, we notify the client of the result in a letter, reminding them of future actions they will 
want or need to take, and that we are closing their file. We return all originals to clients. We give clients a copy of 
the file when requested. 

 We cull the file of duplicates and anything that isn’t part of the file. Enumerate typical things that need to be 
retained, and those that do not need to be retained, after closing a file. 

 We shred or permanently delete private information we culled. 
 If the firm keeps paper, we store the paper file in X locked cabinet(s) in Y order (for example, by file number or 

alphabetically by client’s last name).  
 If the firm is paperless or less-paper: We scan the file, review the scan for accuracy before we shred the paper file, 

and shred any paper version once it is verified. An important part of the policy is determining where you keep the 
electronic version, to keep it backed up and uncorrupted but also secure and inaccessible to hackers. Some store it 
unconnected to the internet. Others store it in the cloud after careful vetting and monitoring of the cloud vendor. 

 On the destruction date, we review the file one more time, then we shred or permanently delete the file. Review of 
a file before destruction should be supervised by lawyers, but shredding old files is a good job for a temporary 
worker or summer intern. 

 We wipe clean all laptops, scanners, printers, and other devices data can be stored on before we get rid of them.  
 We notify clients of our data retention policy at the beginning and end of representation. Our notification includes 

information about how to get a copy of your file, how we store electronic data, and keep it secure. 

Use this basic framework of a file retention policy to build your own, based on your firm’s current systems, or to audit your 
file retention policy. Finally, ask, Are you following the policy you set? If not followed, why? Training may be in order, or 
changing the policy to make it easier and more effective to maintain may be the right approach. 
 
Naming Conventions 

No matter how you implement your less-paper office, one factor critical to its success is creating a file-naming protocol. 
Where possible, your office should use a protocol that makes locating files easy, and allows any person to determine the 
contents of a given file. Document management software (DMS) automatically performs this function, although many offices 
do not have DMS. For those offices, files should still be organized in an easy-to-use style, generally by client name (after all, 
who remembers every matter number?). There are then, generally, subdirectories for correspondence, pleadings, 
discovery, medical records, etc. 

After you establish a file organizational structure, you should define a file-naming protocol. For example, save all letters as 
“Ltr to XXXX re YYYY, Date.” I recommend that dates be in YEAR-MONTH-DATE format (2005-10-28) because it makes sorting 
similarly named files far easier. Thus, if you have four letters to Attorney Smith about settlement, they  will sort in date order 
when you are searching. 

It is essential the file naming protocols are used universally throughout the firm. You may have one or more practice groups 
with a separate protocol, because the practice area deviates so significantly (e.g. transactional practice areas have different 
focuses from litigation practice areas), but there should still be universal use of the highest level of organization. That means 
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you need to find a convention that is the most user friendly and instinctually searchable by the widest swath of mandatory 
users possible. In other words, don’t forget to consult with paralegals and associates who do the work. If it isn’t 
understandable and searchable by the common user, it will get ignored or cause wasted time and delay. 

Implement uniform file naming conventions. It is less difficult for a solo to implement uniform file organization and naming 
conventions than it is for a firm of more than one because it only needs to satisfy one person’s proclivities. What is intuitive 
for one is not for another, how one thinks things are easily found for one is not always the same for another. After workflow 
and processes are analyzed, communication to reach a consensus or near-consensus on what would be the most effective 
file naming conventions is key to success.   

Taxonomy is the organizational scheme or indexing system a firm uses to manage and archive documents. It is crucial that 
this be given serious consideration and the final result to standardized firm wide. If documents are named and stored 
accurately and efficiently across the entire firm the database is more searchable—and therefore usable--for everyone.   

Determine the most important pieces of information to you and your staff. Usually it is the names of the parties or clients, 
the type of document, date it was made, and/or a file number or case number. Design a system that includes the most 
important information in the title of the PDF.   

Create a consistent labeling system. Consider such things as:  

 What format will you use for dates? (e.g. MM-DD-YY or MM/DD/YYYY or YYYY-MM-DD)  
 Should names be entered first last or last, first?   
 What are your universal abbreviations? (e.g. Deposition – DEPO, Medical Records – MR, Request for Production – 

RFP, Interrogatories – ROGS,  Pleading – PLEAD, Parenting Plan – PP, Power of attorney – POA, etc.) Make a list for 
your Policies and Procedures Manual.  

 Determine the order the information will be listed.   

Put the most important information first. For example, if you organize all files by client last name, then client first name, start 
every document title with the client’s last name followed by the client’s first name. If the firm, instead, organizes based on 
case number or file number, place that number at the beginning of the file.  

Do not give in to wanting short, easy titles for your PDFs. Think about how you search for things later, when you cannot find 
them, and try to make your title the way you would have that search come to your mind most readily. Put more than one 
form of search point of reference into the title, so that if one fails to be intuitive, another can apply. For example, you may 
want to find the Corsair case file later, or you may just want to find an example of a Buy and Sell Agreement which just 
happens to be in the Corsair case. If you remember only half of this information, you still have a good chance of finding it if 
you have labeled the Buy-Sell with both what it is and who the client was in the title.   

Have uniform folders for certain case types and implement the folder template into every electronic file at the opening of 
the case. Know where each item goes and put it into the proper file. Use a shared file system so that all lawyers and staff in 
the firm work from the same set of documents and old versions exist unless on purpose and labeled accordingly. 

Getting Your Team Committed to a Paper Free Environment 

Involve the team. Everyone owns their position in a law firm and each position is essential to serving the clients. Give each 
one a voice, but have a lead who makes the final decisions and lays out the plan. One grumbling, disgruntled employee can 
unravel a plan to go paperless, depending on where she is in the lifecycle. Support for that plan should be top-down. 
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Sometimes the loudest grumblers can be partners, and when leadership says it doesn’t work, it gives permission for everyone 
else to say the same.  

When something isn’t working though, make adjustments. That is part of implementing a new process. In an ideal world, you 
made a plan for how to go paperless and followed it. The implementation probably looked something like: 

1. Evaluate current systems and processes. 
2. Audit current files and retention policy. 
3. Determine you want to go paperless in two phases: Phase one is current open files. Phase two is pat files 
4. Create new paperless workflows 
5. Train and implement new workflows. 
6. Get help with old files. 

But there are always unknowns and issues that come up during and after implementation. These cases studies illustrate 
certain pitfalls and offer solutions: 

Case Study #1 

Bender and Crankton went paperless last year. They had a planned office move that put them in a smaller space, and they 
decided that the best thing to do would be to make everything paperless at the same time the implemented the move. This 
gave them a tight deadline for completion, so they did a rush job of planning and implementing the move. They decided to 
just bring in a couple temporary workers to scan everything they had, and thought they’d do file naming conventions after 
the move. Now that they are in their new office space, but their electronic documents are named things like 74859567012.pdf 
and they have no idea how they are going to sort out certain old files and determine what goes where. 

Bender and Crankton gave into the urge to save absolutely everything with an intention to sort through it later. 
Electronic storage is cheap. The sorting is like the filing you never get done—it usually languishes. And the mass saving of 
everything under the sun reduced searchability and efficiency. With basic, simple naming conventions in place and a little 
bit more time training those temporary workers in what they were doing, they could have had one person scanning and the 
other checking and categorizing each document saved as they went.  
 
To fix this problem, the firm will likely need to 1) establish a document retention policy with clear deadlines for 
destruction, and 2) establish simple, easy to follow naming conventions. Then, it will likely need to bring in temporary 
workers again, who will have to search and either destroy or categorize every oddly named documents, based on the new 
retention policy and naming conventions. Time would have been saved by shredding files fit for destruction and doing the 
naming and categorizing contemporaneously with the scanning.  
 
Case Study #2 

Fox Firm thought it did everything right with the new paperless workflow. It hadn’t been in business too long (only eight 
years) so it didn’t have as many files as some firms do. May, who ran the project, gave everything a file retention period fit 
for the practice area (usually seven years), sound naming conventions, and had everything scanned by Eve. They are nine 
months into their new system. Very recently a few deadlines were missed on a couple cases. They are, naturally, freaking 
out. A load of extra work had to be done to address the issue and clients were upset. May has an epiphany that the missed 
deadlines are linked to the new paperless process, and goes back to the drawing board to improve the workflow. 

May should have put a step for calendaring essential deadlines in the master calendar and on the appropriate lawyer’s 
calendar before a document was scanned. One of the greatest risks of a paperless office is that the scanned item does not 
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get calendared properly before it is scanned and filed away, and that important dates aren’t noted before they pass. 
Protocols should include a step calendaring such as all deadlines are calendared before scanning and destroying the paper 
copy or scanned documents is checked for accuracy and deadlines are noted and properly calendared before destruction of 
the paper document. 
 
Say that May goes back to her protocol and sees that deadlines are clearly part of the workflow, but when she watches 
support staff they have skipped that step. Then it is a training issue. Retrain staff to put deadlines in the proper places 
electronically again, and reevaluate. If it continues to be a problem, consider if it is a staffing problem. Since it is such an 
important part of the law firm’s functionality and ethical responsibilities, it makes sense to have your most detail-precise 
staff person doing it, and/or two sets of eyes check the deadlines are calendared and accurately. So, maybe the above 
system becomes a) Eve scans and puts in deadline, b) hands paper off to Sam who checks accuracy and completeness of 
scan, and accuracy of deadline in calendar, then c) approves and hands back to Eve to shred.  
 
Case Study #3 

Alex has been going paperless for three years. His firm has three paralegals and one other lawyer. It isn’t big, but they are 
very busy. They plan and move another aspect to electronic every now and then, but the project just goes on and on. 
Meanwhile, he has 186 boxes in storage he is still paying for—20 years in practice in a highly paper-heavy practice area 
such as immigration—and his staff are looking at him with thinly veiled disdain every week, when he talks about the his 
“new paperless workflows” being “a work in progress.” 
 
Alex needs to put a pin in it and move on. There is a danger to treating this major project as a “work in progress.” If you do, 
it heightens the possibility you never reach the final switch over to the new system. If it is broken down into smaller 
projects, they should have a beginning and an end date. Alex needs to make a final push to get this things done on a set 
date. A final date can be changed, but it makes the goal more emergent, less “when you can get to it.”  
 
Even if the project isn’t everything you imagined it would be, calling it complete has power. Alex may decide to create 
phases for current files and past files, and be able to easily pronounce current files less-paper done at the moment. Phase 
two may largely be a document retention policy creation and implementation, with a weekend reviewing files from storage 
and organizing mostly their destruction. Don’t underestimate the power of destroying massive amounts of paper files and 
getting rid of the filing cabinets. It will be good for the soul and morale to get this off everyone’s plate.  
 
Case Study #4 

Salvatore and Elizabeth were put in charge of the paperless office initiative at their firm. They work in the same department 
and don’t know many folks from other departments. They came up with a plan based on a presentation, implemented it, 
trained everyone, and felt good. A few months later, they see Sue sauntering over to her wall of filing cabinets to search for 
something from a file. They looked at each other and rolled their eyes. “That Sue never listens to anyone,” Elizabeth 
murmured. But then they started seeing several lawyers with stashes of paper files in their office, and paralegals are 
complaining that files appear incomplete online, or that they can’t find things. What is going on here? 
 
It’s hard to say what in this new paperless workflow has failed, on these facts, but there is definitely a need to evaluate the 
new processes and determine what isn’t working right. Paper does not disappear from every paperless office—there are 
lawyers who cannot effectively research or write without a certain amount of paper drafts, for example. That is alright. It 
doesn’t mean you will never print a paper copy of something again. It just means that the accessibility and searchability of 
the entire file will be more widely available to everyone in the firm, and that at a certain point in the lifecycle of the file 
there will be no more paper. Even if it is at closing the file that you scan and manage the entire file as paperless, you could 
save thousands of dollars in storage fees, office square footage, cabinets, and time wasted searching for a copy of 
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something or a file that wasn’t properly checked out and returned.  
 
Salvatore and Elizabeth need to make inquires. They did not get hardly any input from staff at the beginning and it is likely, 
because of that, they didn’t have as much buy-in from everyone as thought. They may need to make adjustments to the 
workflow, to match different practice area or worker needs, or do more training with everyone. It is possible their search 
functionality isn’t working for everyone. Searchability is important when one works in a paper setting, but one can 
discover a misfiled paper or “run into it” around the office. It is absolutely indispensable when working in a paperless 
system, because one will not come by that misfiled or difficult to search for document in electronic format. Without a 
document management system giving the firm that structure, they may be sing the effect of people just trying to hold onto 
what they need to do their job well. The item may as well never have been filed if it cannot be retrieved through a smart 
search. This could be a naming convention or practice area difference issue. On the other hand, they may have done 
everything right and Sue may be just rebelling. If they get rid of those filing cabinets, she can’t persist in old behaviors. 
Either way, it’s time to start talking to people and evaluating progress. 
 
Checklists 

Checklists are crucial when creating and modifying your workflows. They ensure everyone uses the same procedures and 
prevent errors. You are teaching people something new, after all. Give them clear guidance on what the procedure will be in 
writing. 

Some Ways to Improve Your Paperless Workflow: Creating PDFs from Microsoft Outlook Emails 

One of Acrobat’s best features is its ability to convert one or more emails, or email folders, into a PDF Portfolio. This feature 
is only available in Outlook or Lotus Notes and not with other email clients. When you create an Outlook Email Portfolio, or 
add emails to an existing Portfolio, Acrobat not only saves the original email but also saves any attachments to the email in 
their native/original formats. 

Saving email as a Portfolio also serves as an easy way to review a client’s or matter’s communications (you can also save sent 
email) and as a means of archiving communication, thus complying with an attorney’s ethical obligation to preserve a client’s 
file, including email. 

The Adobe PDF toolbar or ribbon bar tab is installed as part of an Acrobat installation. The options on this tab will change 
depending on the specific task you are doing. 

 When Sending Email: When a user creates a new email message, the Attach as Adobe PDF command appears on the 
ribbon, allowing the sender to attach different file types, such as a native Word file, as a PDF file in the email. This is 
a helpful option for large files, such as PowerPoint presentations, that may be more compressed as a PDF. 

 Viewing Email Messages in Outlook: There are three sections on the Adobe PDF section of the ribbon when viewing 
messages in the Reading pane. Only the Convert section appears when reading an email in its own window. 

o Convert: There are two options in this section. The Convert Selected Messages option converts one or more 
selected email messages to PDF. The Convert Selected Folders option converts one or more selected folders 
to PDF. These options allow users to either create a new PDF or to append the selected messages or folders 
to an existing PDF. The Append command is particularly handy because it allows you to add messages relating 
to a specific topic or matter to an existing PDF. In addition, when you append messages or folders, Acrobat 
only appends messages or folders that were not previously included in the PDF. This means that there are no 
duplicate messages stored in the PDF. 
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When you use the Selected Folders option, Acrobat displays a dialog box showing all of the folders in Outlook 
and allows you to choose whichever folder or folders you wish to include. 

Whether you are creating a new PDF from one or more emails or one or more folders, Acrobat then allows 
you to specify the location where you want to save the file and the name you want to use. Acrobat will then 
convert the emails and will show you the progress of the conversion. 

Acrobat creates a Portfolio from the emails rather than one single PDF file. The Portfolio contains not only 
the email messages but also any attachments to the emails in their native format. The default view lists the 
number of attachments to a particular email but does not automatically display any links to open them. There 
are two ways to display attachments.  

The first is to use the View menu on the main menu and choose View>Show/Hide>Navigation 
Panes>Attachments. Acrobat then displays the Attachment pane to the left of the email message. 
Alternatively, you can select Open Document to display the specific email message as a single PDF outside of 
the Portfolio. Once the single email is open, you will need to open the Navigation pane on the left and click 
on the paper clip to view the available attachments. When you choose an attachment, it will open in the 
default program on your computer for that file type. 

The content of the Portfolio is fully searchable, so you could find a specific email just by remembering and 
searching for a word or phrase in it. To do so, select Edit>Search Entire Portfolio from the main menu or 
Ctrl+Shift+F. Saved messages are also date-stamped with the date that messages were sent or received, not 
the date on which they were saved. 

Some Ways to Improve Your Paperless Workflow: Editing Text in an Existing PDF 

You can edit or delete the actual text in virtually any OCRed PDF file, unless the document’s security settings prohibit it. 
Assuming you are able to make changes, to edit the existing text, open the PDF file, and select Edit PDF from the Tools pane. 
The Format pane opens on the right and the Edit PDF toolbar opens above, just below the main toolbar. 

If the document you are opening is a scanned document that has not been OCRed, Acrobat DC will automatically run OCR to 
convert the document into an editable image. By default, only the current page you are viewing is OCRed, but you can change 
this setting if you wish in the Format pane under Scanned Documents, Settings. PDF documents that were created from a 
program like Microsoft Word will be editable without being OCRed first. 

Once the document is OCRed, you will see boxes around any text that can be edited. Select Edit from the toolbar, place your 
cursor in the document, and begin typing as you would in any word processing file. You can also delete any text by either 
backspacing over the text or, if you want to delete an entire box, select the box and press the Delete key. 

Acrobat will automatically attempt to match the fonts in the original document and will “reflow” the paragraph. When your 
changes are complete, be sure to save your file. 

Some Ways to Improve Your Paperless Workflow: Extracting PDF Files or Tables to Excel Spreadsheets 

You can export an entire PDF file or a selected table in a PDF file as an Excel worksheet. Keep in mind that an entire exported 
PDF file will not necessarily be formatted in a usable format in Excel, but you do have the ability. Most likely, you will be 
exporting tables of data. 

Exporting a Table to Excel 
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To export a table, in Acrobat choose File>Open and open your PDF document. In order to select the table, drag your mouse 
around the table so that the entire table is selected. Right-click the selected table and choose Export Selection As. In the 
Export Selection As dialog box, choose Excel Workbook from the Save As Type dropdown menu. Name the file and save it to 
your desired location and click Save. Excel will open your document automatically as long as you have the View Result check 
box ticked under the Save as type dialog box. 

Exporting an Entire PDF File to Excel 

If you do want to export an entire PDF file to an Excel spreadsheet, in Acrobat choose File>Open and open your PDF 
document. From the main menu, choose File>Export To>Spreadsheet>Microsoft Excel Workbook. This saves the file to an 
.xlsx format. The Windows File Explorer window opens and allows you to navigate to the folder where you want to save your 
file. Name the file and click Save. Excel will open your document automatically as long as you have the View Result check box 
ticked under the Save as type dialog box. 

Alternatively, open the PDF and choose Export PDF from the Tools pane. Here you are given the option to export your file to 
Spreadsheet. Clicking the Export button allows you to proceed. 

Some Ways to Improve Your Paperless Workflow: Using the Acrobat Word Round Trip (A Great Way to Send a Document 
to One Person for Review) 

There are many ways to send a document to another attorney for review. Many attorneys prefer, however, not to send Word 
documents to another attorney because they are concerned about relying on Tracked Changes in the event the other attorney 
makes changes that do not appear in the returned document. Acrobat has many options to avoid this concern. Among the 
easiest is the Acrobat Word Round Trip, in which one party converts a Word document into a PDF, sends it to another person 
(who only needs the free Acrobat Reader), who adds any proposed changes or comments, and returns the document to the 
sender. When the sender receives the PDF with the proposed revisions, he or she can open the PDF in Word and review the 
suggestions using Track Changes. Here is how to do it. 

 Open a document in Microsoft Word. Go to the ACROBAT tab on the ribbon bar. In the Review And Comment section, 
click on Create and Send For Shared Commenting. Acrobat opens an Explorer window. Name and save the document 
(as a PDF) in your desired location.  

 Acrobat will create a PDF of your document. 

 If you are not connected to a network, you will need to do the following steps. After the document opens in Acrobat, 
it will display the Send for Shared Commenting dialog. In the top box, use the default setting, that is, collect comments 
from reviewers in My Network Folder (manually send). Click Next. 

 Acrobat will then ask you to specify the location on your network where it will store the shared review file.  

 You can then either send the document using Acrobat or save a local copy and manually send it later. 

o If you do so, Acrobat will ask you to specify where to save the file. Acrobat then asks you to name the location 
where you saved the file. 

o If you are connected to a server, you may not have to perform the steps in the preceding paragraphs. 
Regardless of which process you must use, Acrobat will prompt you to save a local copy and manually send 
it later. 
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 In this process, Acrobat will create (1) a PDF of your document, and (2) a second PDF of your document with “_review” 
appended to the document name. This “_review” document is the one you will send to reviewers. 

 If you are manually sending the file for review, you do not need to enter any email addresses in the dialog box. Click 
Finish and Acrobat will save the shared review-enabled PDF file. 

 If you are using Acrobat to send the file, in the next dialog, enter the email address for the person to whom you want 
to send the PDF for review and commenting. You can change the review deadline by clicking on the hyperlink in this 
dialog. Click Finish. 

 When the recipient opens the file, Acrobat will ask the reviewer to connect to the review copy. If the reviewer has 
access to your server, he or she can do so, and any comments will automatically be collected. If the recipient does 
not have access to your server because he or she is outside your organization, he or she will choose to work and make 
any comments offline. 

 When you receive the annotated version, go to Word and click on the ACROBAT tab on the ribbon. In the Review And 
Comment section, click the dropdown next to Acrobat Comments and select Import Comments from Adobe Acrobat 
DC. This will open a dialog box. Click OK to begin the import process. 

 Under Choose Files, browse and select (1) the PDF file with the comments you want to review and (2) the Word file 
you want to incorporate the comments into. You can choose whether to import All Comments, All Comments with 
Checkmarks, Text Edits only, or Apply Custom Filters to Comments. Generally, you should select All Comments. Also, 
select or check the box next to Turn Track Changes On Before Importing Comments. Click Continue. 

 Word will display the Successful Import dialog and list the number of items imported. Click Integrate Text Edits. 
Acrobat will then walk you through the various proposed revisions. You can Apply or Discard any revision or skip it 
by selecting Next. You can also choose to Apply All Remaining revisions as well. When you are done, you will see the 
Text Integration Summary, with the new revisions highlighted. 

o Note: You can send a document to multiple reviewers using the Acrobat Word Round Trip, but Word will 
warn you, after the first revisions are imported, that the original document has been changed. In those cases, 
consider using the Group Review Processes.  

Using Portfolios for Discovery, Real Estate Closing and Other Matters 

Portfolios can facilitate advanced classification or display of documents. For example, you could compile documents, 
determine which are privileged, categorize documents, or perform actions for any other purpose. This method of analysis 
builds on the use of comments outlined previously for discovery and depositions and can be used in almost any type of case. 

 Right-click on any thumbnail and select Portfolio Properties to view and select the data to display about each 
document, as well as the order in which the information will be shown.  

 Next, while still viewing Portfolio Properties, click Add and create a new field, such as Privileged. Make sure there are 
checks in the boxes next to any fields you want to view, including the newly created ones. Click OK when you are 
done. 
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 Click on View>Portfolio and select Details. The Portfolio will display all of your selected fields. To edit the value in the 
field, such as adding Yes to the Privileged value, right-click on the file name, select Edit Value, and choose the item, 
such as Privileged. Type in “yes” or whatever value you desire and click OK. 

 You can then sort on any value or remove documents that do not have the desired value from the Portfolio. For 
example, by sorting on Privileged, you could then delete from a Portfolio of potentially discoverable documents any 
document that is marked with a value of “yes” in the field called Privileged. 

Some Ways to Improve Your Paperless Workflow: Dealing With Handwritten Documents That Cannot Be OCRed?  

Acrobat cannot generally convert handwriting or poor-quality documents into searchable text. At times, you may be able to 
use the Correct Recognized Text command. However, when the document is of very poor quality, the handwriting cannot be 
OCRed, or an image cannot be OCRed, there is an alternative that permits users to search for the text. 

 Open the Comment toolset. 

 Click the Add Sticky Note (Ctrl+6) tool. 

 Drag your cursor to the location in the document where the suspect text appears and click. 

 A Comment dialog box will appear and display the name of the Acrobat user. In the box, type the correct text. 

 Save the document. 

To Locate the Additional Text 

 Open the Find (Ctrl+F) or Advanced Search (Ctrl+Shift+F) dialog. 

o Using the Find dialog, type the desired text in the dialog box, click the Down arrow in the search box and 
select “Include Comments,” and then click Previous or Next. Your results should include the text in the 
comment box. Note that the comment box appears in the Comment panel on the right of the document. 

 Using the Advanced Search dialog, type the desired text in the dialog box, select “Include Comments,” and then click 
Search. From this dialog, you can search within one or many documents by selecting “In the current document” or 
the “All PDF Documents in” dialog. 

Some Ways to Improve Your Paperless Workflow: Using Actions and Custom Commands (Acrobat Professional Only) 

Actions, a feature available only in Acrobat DC Professional, allow users to automate repetitive tasks. If you think of one of 
the workflows in your cases (such as a list of the things you do to prepare for trial and the order in which you do them), 
Acrobat actions do the same type of thing with your PDFs. As a result, actions allow you to consistently handle your files. For 
example, you could create an action that OCRs files and then reduces their size. 

Depending upon the action, you might be prompted to tell Acrobat what steps to take, while other actions can be performed 
once you specify which file, files, or folders to process. For example, if you include “Remove Hidden Information” in an action, 
Acrobat will require you to specify the information to remove. But if your action requires Acrobat to create bookmarks, that 
process can be performed automatically. 
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Acrobat Pro includes a limited number of actions, such as preparing documents for distribution or creating accessible PDFs, 
but most are not particularly focused on legal users. With a little practice, you will save time by creating and using actions. 

Using Actions 

All actions (whether created by Acrobat or by you) are available by going to Tools and selecting the Action Wizard. The Actions 
List on the right of the window displays all available actions. 

When you select an action, Acrobat displays the steps in the action on the right on the window, as well as the files to be 
processed. You can select other files from this window. When you are ready to process the action, click Start. The Start button 
changes to a Stop button, which you can click on to stop the action at any time. 

If the process requires additional input, Acrobat will prompt you. When the action is done, the Start button will say 
“completed.” Below the dialog is a “Full Report” link, which you can select to display a list of all tasks performed. 

Obtaining Additional Actions 

The Acrobat Actions Exchange (https://acrobatusers.com/actions-exchange) is a great website for obtaining actions created 
by other Acrobat users. You can access the site from Acrobat by selecting More Actions (Web) on the Action Wizard toolbar. 
After downloading the desired action to your computer, select Manage Actions and then Import. Navigate to the location 
where you saved the downloaded file and click Open. 

Warning: Be careful when downloading any files to your computer. Always run antivirus software, and only download files 
from reputable websites. Downloading files from unsafe websites can be very dangerous and could result in damage to 
your computer and your network. 

Some Ways to Improve Your Paperless Workflow: Using a Security Envelope to Send Attachments of ALL Types 

Acrobat permits users to create a Security Envelope, a secure container in which to send and receive files. Because Acrobat 
files may contain attachments in non-PDF format, a security envelope also provides a convenient way to include all of those 
files. Moreover, the recipient can open the Security Envelope with the free Adobe Reader. 

Security Envelopes Are a Great Solution for Ensuring Email Security 

Many state and local bar associations have opined that lawyers have an ethical obligation to encrypt their email to prevent 
unauthorized persons from viewing confidential email communications and attachments. Although Acrobat is not per se a 
secure product, if you use strong passwords, then a Security Envelope is an excellent way to comply with this ethical obligation 
because a Security Envelope may contain all types of files and does not have to include any PDFs. 

To create a Security Envelope, go to Tools and select Protect. Select Create Security Envelope from the More Options 
dropdown on the toolset to view the Create Security Envelope dialog, which displays all of the steps in the process. 

Resources 

Acrobat DC tutorials, free online tutorials by Adobe.  

Acrobat for Legal Professionals – A blog by Rick Borstein. This is the very best resource for legal professionals using Adobe, 
hands down. Some screen shots may be out of date, but the context can still answer your pressing questions.  
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Create a Transparent Signature Stamp for Adobe Acrobat X, YouTube video by Catherine Sanders Reach’s, courtesy of The 
Chicago Bar Association. 

The Ultimate Guide to Adobe Acrobat DC, Daniel J. Siegel and Pamela A. Myers, ABA publication March 2018. Another very 
good resource recently updated. If you are an ABA member, you get a discount on the ABA website.  
 
The Lawyer’s Guide to Records Management and Retention, Second Ed., Cunningham, George C., ABA Law Practice Division 
c. 2014.   

Paperless in One Hour for Lawyers, Sheila Blackford and Donna S.M. Neff, ABA, 2014.  

Cloud computing due diligence guidelines, courtesy of the Law Society of British Columbia at 
http://www.lawsociety.bc.ca/docs/practice/resources/guidelines-cloud.pdf  
  
Cloud computing checklist , courtesy of the Law Society of British Columbia at 
http://www.lawsociety.bc.ca/docs/practice/resources/checklist-cloud.pdf   
 


